
IBM TotalStorage™ NAS 200
Model 25T

Release Notes
For Release 2.7

Part Number 68P3581

���



THE INFORMATION CONTAINED IN THIS DOCUMENT IS PROVIDED ON AN ″AS IS″ BASIS. In no event will IBM® be liable for
damages arising directly or indirectly from any use of the information contained in this document.

First Edition (October 2002)

This edition applies to Release 2.7 of the IBM 5194 TotalStorage NAS 200 Model 25T (product number 5194–25T).

Order publications through your IBM representative or the IBM branch office servicing your locality. Publications are
not stocked at the address below.

IBM welcomes your comments. A form for reader’s comments is provided at the back of this publication. If the form
has been removed, you can address your comments to:

International Business Machines Corporation
Design & Information Development
Department CGF
PO Box 12195
Research Triangle Park, NC 27709–9990
U.S.A.

You can also submit comments on the Web at:

www.ibm.com/networking/support/feedback.nsf/docsoverall

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information in any
way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 2002. All rights reserved.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.

Part Number 68P3581

http://www.ibm.com/networking/support/feedback.nsf/docsoverall


Release notes

This document contains the release notes for the Release 2.7 for the IBM
TotalStorage™ NAS 200 Model 25T, hereafter referred to as the NAS 200.

Refer to www.ibm.com/storage/support/nas for possible updates to these release
notes and for copies of the base documents.

Refer to www.ibm.com/storage/support for translated version of this document.

The 2.7 CD includes these drivers:

v ServeRAID™ 5.11.01

v Intel PROSet II Version 5.3.42.0

v Alacritech SLICuser Package 5.34

v Drivers and firmware upgrades:

– ServeRAID Driver Version 5.11.01

– Intel Ethernet Gigabit Version 6.2.21.0

– LSI On-board SCSI Version 1.8.12

– Alacritech Quad-Port Ethernet Adapter

- Alacritech ATCP Driver Version 5.34.0.0

- Alacritech Simba Driver 5.32.0.0

– Adaptec SCSI LVD Win2k Device Driver Version 4.10.4000

Known problems and solutions
For Release 2.7, there are several known problems. Table 1 lists these known
problems and suggested solutions.

Table 1. Known problems and solutions

Abstract Problem Solution or workaround

Problem installing
Veritas Backup Exec

During installation of Veritas Backup Exec 8.6, the
program attempts to create a new cluster group
and move resources (like the shared drive) into a
group called Backup Exec. During this process,
Veritas installation aborts with the following error
message:
Severe - Error in Creating the Cluster Group.

This problem may also happen when you are
using the Cluster Administration tool or
Cluster.exe tool to try to add a network resource
name that contains an underscore (_) character;
you might receive an error message that indicates
that the resource name contains invalid
characters.

Workaround: The workaround currently
is to manually create the groups in the
Cluster hive or not use the
“underscore” character.

Server Wizard appears
during the login process

When logging on to the NAS Appliance using
Administrative User other than the default
“Administrator” account, a Wizard dialog is
invoked, prompting you to configure the server.

This is normal behavior when a new
Administrative User logs on to the
NAS Appliance. A Server to-do list is
created every time a new
Administrative User logs on to NAS
200. Bypass the wizard and use the
IBM NAS Admin.msc to configure the
Appliance.
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Table 1. Known problems and solutions (continued)

Abstract Problem Solution or workaround

Disk Wizard completes
with error

If invoking the Microsoft Disk Manager when the
Appliance has a hardware RAID Solution, and no
external Fibre Channel storage is attached, the
User sees a Wizard for writing a signature to a
drive that is detected. The User finishes the
wizard and gets an error on completion that Disk
″0″ is unknown.

This is normal behavior on Fibre
Channel and RAID-based Appliances.
Hook up the Fibre Channel connection
to the HBA and it should detect any
configured external Logical Volumes.
Note: The “Unknown disk” is the
“Pseudo disk” in Device Manager and
is used by Fibre HBA.

Plug-in does not start When selecting plug-ins in the IBM NAS
Administration console, the required plug-in does
not start.

Right-click the plug-in; then click
Refresh. This is standard Microsoft
Management Console (MMC)
behavior.

IBM Appliance Advance
Configuration Utility

The IBM Appliance Advance Configuration Utility
(IAACU) console does not allow the creation and
placement of the Appliance within a designated
group or family.

This is normal behavior when the
IAACU Console has been updated to
support the latest appliances. This
may be addressed with a future
release of the console.

FTP virtual directory is
not displayed in directory
listing

A virtual directory in an FTP site cannot be seen
by the client.

Visit the Microsoft Web site for a
workaround to view the contents of an
FTP virtual directory.

ServeRAID Agent
terminated unexpectedly

When the appliance shuts down, the ServeRAID
agent logs an event to the System Event Log that
the agent has shut down unexpectedly.

This is normal behavior for the
ServeRAID agent, and the agent starts
normally when the appliance is turned
on.

Functional notes
The following sections contain functional information.

NFS share configuration in Server Appliance Kit

Error when assigning client group to an NFS share
When assigning a client group to an NFS share, you get the message:
The client machine name XXXX could not be resolved.

(where XXXX is the name of a defined client group)

To work around this problem, either:

1. Assign the IP address of the machine instead of using the client group name,
OR

2. Use the desktop interface by navigating to the actual folder that you want to
share using Windows Explorer; then right-click the folder and select Sharing.

Error when assigning machine IP address to an NFS share
When assigning a machine IP address, you get the message:
The client machine name XXXX could not be resolved.

(where XXXX is the IP address of a client on your network)

To work around this problem, either:

1. Ensure that the client machine is on the network and that you can ping it, OR
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2. Use the desktop interface by navigating the actual folder that you want to share
using Windows Explorer; then right-click the folder and select Sharing.

Re-establishing SNMP service
The SNMP Service has been turned off in Release 2.7 to increase performance and
security. This service can easily be turned on by following these steps:

1. Use Terminal Services or attach a monitor, keyboard, and mouse to the
appliance

2. Double-click IBM NAS Admin Snap-in.

3. Expand Maintenance and click Services

4. Right-click SNMP Service and select Properties.

5. Set Service to “Automatic” or “Manual” (default is “Manual”); then click Apply.

6. To start SNMP service, click Start.

Persistent Storage Manager Notes

FAT32 file system functional limitation
Persistent Storage Manager (PSM) will not allow a Persistent Image (snapshot) to
be taken of a FAT32 file system formatted volume. The Maintenance (D:) partition is
formatted FAT32 by default, to allow system restore from a DOS boot disk by a
backup of the system volume (C:) stored as a file on D:. Therefore D: must be
formatted FAT32. The NAS Backup Assistant can be used to back up C: to D: using
a PSM-generated snapshot to allow backup of open files. However, a PSM
snapshot-assisted backup of D: is not possible because D: must be a FAT32
volume, and attempted snapshot-assisted backups of D: will fail.

You can back up D:, if you do not use PSM.Backups of D: which do not use PSM to
generate a snapshot will succeed as long as other variables (such as sufficient
space available on the destination volume) are correct.

Command line interface
PSM uses several system-level files, one of which has a command line interface.
Use of this is supported only for IBM-provided applications and services, as well as
allowing IBM support technicians to assist in debugging problems. All PSM function
(including sophisticated scheduling and automation of remote management) is
provided by the Graphical User Interface described in the User’s Reference.

PSM failure to take a snapshot
Defragmentation of managed storage is often an essential maintenance task for
Windows machines. Defragmentation of a NAS which is using PSM is complicated
by the data protection activity of PSM. PSM caches all the old data being
overwritten by the extra write traffic generated by the defragmentation engine.
Therefore, defragmentation of volumes with snapshots managed by PSM is
disabled: the defragmentation engine will complete and report success, but the
volume will be unchanged. However, defragmentation remains necessary, and PSM
will even cease taking snapshots if its cache file becomes too fragmented, reporting
the following errors to the System Event Log:
<date/time> psman5 Error None 4135 N/A <mach.name> A persistent image could

not be created due to error 0xe000103f.
<date/time> psman5 Error None 4159 N/A <mach.name> Cannot create PSM files

because the volume is too fragmented.

To successfully defragment the volume, delete all snapshots on the volume (ensure
you have a valid backup on hand) using the PSM GUI. PSM allows defragmentation
of the volume; however, the PSM Cache files still remain fragmented, and you will
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not be able to create snapshots. To enable snapshots, you must delete the PSM
Cache files on the defragmented volume. PSM automatically rebuilds them.

Attention: NEVER delete or alter the PSM Cache files or directory on a volume
that still has snapshots.

Cache Deletion Procedure:

1. Open Windows Explorer and click the defragmented volume under “My
Computer” so that the top-level contents of the volume are displayed in the right
pane. Click Windows Explorer→Tools→Folder Options. Select the View tab.
Ensure that Show Hidden Files and Folders is selected, and that Hide
protected operating system files is not selected. Click OK to close and apply
the Folder Options settings.

2. Press the F5 function key to Refresh the top-directory volume contents. You
should see a folder named “Persistent Storage Manager State.” Right-click the
directory and select Properties. Select the Security tab. Select Administrators
in the Name field. Ensure that Full Control is checked in the permissions field;
the other permissions should automatically become selected. Click OK to save
the security settings and close.

3. Right-click the folder named “Persistent Storage Manager State” again, and
select Delete. Click Yes at the pop-up warning. Then, right-click the Recycle Bin
icon and select Empty Recycle Bin to complete the deletion of the PSM Cache
directory and contents.

PSM should be now able to take snapshots again. Creating the first snapshot will
take a little longer as PSM rebuilds the cache file.

Known issues
1. If a re-extended volume (containing True Images of the pre-extended volume) is

reverted, the re-extended area of the disk is unusable. To reclaim this space,
executed the ″reextend.exe″ utility after reverting from a True Image of the
pre-extended volume. This utility is available in the directory:
“c:\winnt\system32\serverappliance”. Use this utility by typing “reextend -?”.

2. For a volume that can no longer be accessible, Cluster service fails-over to
another node. During an image revert operation, PSM must disable the target
volume. By disabling the volume, Cluster service assumes that the volume has
failed and proceeds with a fail-over while PSM is reverting the image. Therefore,
you might want to increase the default Pending Timeout value for the Cluster to
a number that works for your specific system.

3. During a PSM revert operation in a cluster environment, if the volume times out
and is made unavailable, the revert operation can not finish and data on the
original volume is incomplete. In some cases, the volume can no longer boot.
However, reissuing the PSM revert operation and allowing it to finish returns the
volume to the previous state. For this situation , you might see the following
event log messages:
Persistent Storage Manager recovery encountered error 3221226026 inserting

key (20A0C7:FB) into dictionary.

D:\snapshot\snapshot.0 is not accessible. The disk structure is corrupted
and unreadable.

4. The event log error “a driver below this one has failed in some way for” may
occur when the cache file is full.

5. If all your Persistent True Images on “C:\” are tagged as Always Keep, and the
cache file fills up, the system might experience a BSOD at reboot. It is not
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recommended to flag all Persistent True Images as Always Keep because this
disallows the deletion logic of PSM to delete the older Persistent True Images to
free up cache file space.

6. Default cache setting not being displayed correctly. For example, if you set
cache file % for Volume setup page, say 2%; then take a Persistent True Image,
the value greys out and is not selectable. Then you select restore default
settings, it changes to 20%, you click OK, then go back to that page and the
screen shows 2% not 20%. You must delete Persistent True Images before
increasing the Cache size.

7. In certain cases where the IBM NAS is under load, Persistent Storage Manager
might fail to automatically delete the last snapshot on a volume when the cache
file fills up. The volume typically has one snapshot outstanding when the cache
file exceeds the deletion threshold. At this point, if the system is experiencing
heavy file system load, the write volume prevents PSM from successfully
deleting the last snapshot before the cache reaches 100%. At this point, the last
snapshot must be deleted manually to return to normal operation. The cache file
should then show 0% utilization through the PSM interface (if not, try restarting
the Terminal Services client by closing the window and re-opening it) and PSM
operation should proceed normally. If the issue remains or the cache does not
go to 0% utilization, please call IBM service.

Limitations
1. Only NTFS volumes are supported by PSM.

2. The Page file size must not change and the initial size must be set equal to the
maximum size. This setting is located in the Virtual Memory settings under
System Properties.

3. If the system cannot boot, the revert ability cannot be performed.

4. PSM automatically disables the ability to revert the system boot drive.

5. Microsoft confirmed that the NFS Services for UNIX does not support volume
mount points. The NFS clients are not able to access data on volumes mounted
using a volume mount point. Because Persistent True Images for a volume are
mounted as directory junctions (mount points), and although they are shared
using NFS, the NFS clients are not able to access the Persistent True Image
data. Refer to Release Notes for Microsoft Server Appliance Kit dated June
2001.

Disaster recovery help file inaccurate
Use of the NAS Disaster Recovery feature for backup of the C: to a local FAT32
partition (D:) or a network share requires the creation of a boot diskette. The
diskette is used to boot the recovering NAS and includes a DOS-based operating
system, as well as the location of the image of C: from which to restore. You must
make this diskette bootable. The NAS Administration GUI online help text
inaccurately indicates that this can be accomplished with a menu option in
Windows® Explorer. The correct method is as follows (excerpted from the User’s
Reference):

1. Insert a blank, formatted diskette in the diskette drive of the node.

2. On the Disaster Recovery page, click Create Disk.

3. Click OK on the Create Recovery Disk page. The diskette drive LED will turn off
when the creation is complete. The diskette creation should take no more than
two minutes.

4. The utility makes the disk DOS-bootable. From a command prompt, either
through the desktop of the node itself (with the diskette still in the diskette drive
of the node), or on another system with the diskette in its diskette drive, type:
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a:\fixboot.exe

and answer the prompts.

5. Remove the diskette from the appropriate diskette drive. Label the diskette
appropriately and keep it in a safe place.

Powering on the NAS 200 and the 5194-EXP Storage Units
This procedure replaces the section titled “Powering on the appliance” in the IBM
TotalStorage Network Attached Storage 200 Hardware Installation Guide, and the
sections titled “Powering on the NAS EXP after an emergency” and “Powering on
the NAS EXP” in the IBM TotalStorage Network Attached Storage 200 Storage Unit
Model EXP Installation and User’s Guide. This procedure applies to the IBM
TotalStorage Network Attached Storage 200 and EXP.

To power on the NAS 200 and the NAS EXP:

1. Verify that:

v There is no visible damage, in the event of an emergency powering off. If
there is damage, have the unit serviced.

v All cables are correctly attached.

v All power cords are plugged into the back of the NAS 200 engine (3 cords)
and optional 5194-EXP Storage Units (2 cords).

v All hard disk drives are locked securely in place.

v All switches on the optional 5194-EXP Storage Units are set correctly: the
internal option switches 1 through 4, external option switches 1 through 5,
and the unit ID switch. For more information on these switch settings, refer to
the section titled “Setting the interface options and ID settings” in the IBM
TotalStorage Network Attached Storage 200 Storage Unit Model EXP
Installation and User’s Guide.

2. Wait at least 20 seconds after connecting the power cords.

3. Power on the appropriate device:

v If you are restarting the engine when all optional NAS EXPs are already
recognized by the ServeRAID controller (for example, after a power failure),
power on the devices in this order:

a. NAS EXPs

1) Switch on both power supplies in the back of the NAS EXP.

The NAS EXP might take a few seconds to power on. During this
time, you might see the fault (amber) and the power (green) LEDs on
the NAS EXP turn on and off intermittently.

2) When the power-on sequence is complete, verify that only the power
(green) LEDs on the front and back are on. If one or more fault
(amber) LEDs remain on, refer to the “Troubleshooting” section of the
IBM TotalStorage Network Attached Storage 200 Storage Unit Model
EXP Installation and User’s Guide.

b. Engine

1) Press the power button on the front of the engine to power on the
appliance.
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Attention: The first time you start the appliance, a series of
configuration and system preparation programs that finish configuring
the Network Operating System (NOS) run automatically. These
programs must complete before you use any included applications to
connect to or configure your appliance. Wait at least 5 minutes before
connecting to or configuring the appliance after the initial system start.

2) Verify that the the Power-on LED is on and the Information LED and
System Error LED are both off.

Note: Depending on the system status, other LEDs might be on.

If a problem is detected during the diagnostics, refer to the IBM
TotalStorage Network Attached Storage 200 User’s Reference.

v If you are not using a NAS EXP, power on the engine using the procedure in
step 3b on page 6.

v If you are adding one or more new NAS EXPs, then power on the devices in
the following order:

a. Already recognized NAS EXPs. These are any NAS EXPs that are
already recognized by the ServeRAID controller (see step 3a on page 6
for instructions explaining how to start the NAS EXPs).

b. Engine (see step 3b on page 6 for instructions explaining how to start the
engine).

c. New NAS EXPs. These are all NAS EXPs that are new to the
configuration and not recognized by the ServeRAID controller (see step
3a on page 6 for instructions explaining how to start the NAS EXPs).

Operating system doubles the number of physical CPUs
The NAS 200 incorporates the latest Intel Xeon processors which use a new
technology called Hyperthreading. Hyperthreading allows one physical CPU to run
multiple threads simultaneously, as if it was two CPUs. Because of this, each
physical processor looks like two logical processors to the operating system. This
can be confusing when observing that the BIOS reports the system has one or two
CPUs, and Windows reports that the system has two or four CPUs, respectively.

RAID Array A factory default configuration drive sizes
In the “Additional administrative functions ” chapter of the User’s Reference, there is
a table titled “RAID Array A factory default configuration”. The drive sizes that are
given in the table apply only if the hard disk drives are 36G drives. For clarification,
add a Note 3 to the bottom of the table to read:

If the installed drives are 73G or 146G, the sizes are doubled for the System and
Maintenance Logical drives (for example, the drive size would be 12288 MB for
Logical Drive 1 (System), and the drive size would be 24576 MB for Logical Drive 2
(Maintenance)).

Optional procedure for ServeRAID configuration backup incorrect
In the section titled “Backup and restoration of the ServeRAID storage
configuration” of the IBM TotalStorage NAS 200 Model 25T User’s Reference,
provides two different procedures:

v Backing up from the command window

v Backup up from a bootable DOS diskette

Part Number 68P3581

Release notes 7



The procedure for “Backing up from command window” should not be used. The
procedure for “Backup from a bootable DOS diskette” should always be used.

UPS service error
On the Status of the Windows 2000 for NAS GUI, you will see that the UPS service
has been stopped.

Note: This is the default state of this service on the NAS GUI. In addition, the
“Uninterruptible Power Supply” must be set to Manual in the Control
Panel→Administrative Tools→Services. UPS Service must be enabled
before you can use your uninterruptible power supply device. Do not enable
the UPS Service unless you have an uninterruptible power supply device
attached to your appliance.

The process to correctly configure and enable the UPS Service using the Windows
2000 for NAS GUI follows:

1. Attach your customer-provided RS-232 cable from your uninterruptible-power-
supply hardware to an available COM Port on your NAS appliance.

2. To set “Uninterruptible Power Supply” Control Panel Service to “Automatic” and
“Start”:

a. Log in to the NAS appliance through the Terminal Services Client.

b. Click My Computer→Control Panel→Administrative Tools→Services and
highlight “Uninterruptible Power Supply” service.

c. Right-click Service, go to Properties, and then set Services to “Automatic.”

d. Click Apply; then, to start the service, click Start.

3. To configure uninterruptible-power-supply connections and enable service using
the Windows 2000 for NAS GUI:

a. Click Maintenance → UPS.

b. Select the manufacturer, model, and COM port to which your uninterruptible
power supply device is attached.

c. Select the Enable the UPS service on this appliance check box and click
OK.

Administration notes
This section contains administration information.

NAS Setup Navigator
Release 2.7 includes the NAS Setup Navigator configuration tool. The NAS Setup
Navigator maps out the initial configuration tasks and leads you through the tasks in
the proper order. The tool detects which NAS appliance it is running on and adjusts
the menu and content appropriately. You can follow links to more in-depth
information and to the configuration panels used to perform the steps. You can also
tailor the instructions to fit your needs by selecting optional topics. To start the NAS
Setup Navigator, click on the NAS Setup Navigator icon on the desktop.

NAS Admin tool
If users other than the local machine Administrator have administrative privileges
and will need to use the NAS Admin tool, this file must be copied to that user’s
Desktop folder. Example:
copy "c:\Documents and Settings\Administrator\Desktop\IBM NAS Admin.msc"
"c:\Documents and Settings\<user name>\Desktop"
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IBM Director
NAS Version 2.7 includes the IBM Director 3.1.1 agent in the preloaded software.
The 3.1.1 designation means that the IBM Director 3.1 agent is installed as well as
the IBM Director 3.1 Service Pack 1. If you intend to use the IBM Director Server to
manage your NAS product, ensure that your IBM Director Server and Console are
at the 3.1 version and you must install the IBM Director 3.1 Service Pack 1 on your
IBM Director Server and Console.

For more information about obtaining the IBM Director 3.1 Service Pack 1 for your
IBM Director Server and Console, visit www.ibm.com/pc/support and click Systems
Management.

Supplementary CD 1 contains NAS-specific extensions to the IBM Director Server
to assist you in managing NAS appliances using the IBM Director Server. These
extensions are identified as “IBM NAS Extensions for IBM Director.” One of the
features within these extensions creates an IBM NAS Appliances group on the IBM
Director Console, which allows you to manage NAS appliances as a group, but the
version of these extensions on the CD might not include the most current NAS
products. For the latest version of the IBM NAS-specific extensions to the IBM
Director Server, visit www.ibm.com/storage/support/nas.

The section titled “Rack Manager and inventory enhancements” in the User’s
Reference describes enhancements to recognize IBM NAS components in the Rack
Manager Task of the IBM Director Server and indicated that these enhancements
were available through the application of the IBM Director Server 3.1 Service Pack
1. These enhancements are not available in the IBM Director Server 3.1 Service
Pack 1, but will be made available in a future IBM Director deliverable. For more
information about IBM Director deliverables, visit www.ibm.com/pc/support and click
the link for Systems Management.

Uninterruptible power supply support
Release 2.7 includes support for uninterrupted power supplies. Uninterrupted power
supply devices provide emergency backup power for a specific period of time when
the local power fails. This power comes from batteries housed within the device.
High-performance surge suppression helps protect your appliance from electrical
noise and damaging power surges. During a power failure, the uninterrupted power
supply is designed to instantly switch your appliance to emergency battery backup
power. After you have installed an uninterrupted power supply for your appliance,
you can set options for its operation using the UPS Task on the Maintenance page.
The UPS Task enables you to control how the uninterrupted power supply service
works on your appliance. The available UPS Settings depend on the specific
uninterrupted power supply hardware installed on your system. Before you use your
uninterrupted power supply device, type the following information on the UPS
Configuration page:

v Uninterrupted power supply device manufacturer

v Uninterrupted power supply device model

v The serial port to which the uninterrupted power supply device is connected

To configure the uninterrupted power supply service, see “UPS service error” on
page 8.

To help protect your appliance from power failures, test it by simulating a power
failure by disconnecting the main power supply from the uninterrupted power supply
device. Do not perform this test during production use. Your appliance and
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peripherals connected to the uninterrupted power supply device should remain
operational, messages should be displayed, and events should be logged. Wait until
the uninterrupted power supply battery reaches a low level to ensure a proper
shutdown occurs. Restore the main power to the uninterrupted power supply
device, and check the event log to verify that all actions were logged and there
were no errors. All detected power fluctuations and power failures are recorded in
the event log, along with uninterrupted power supply service start failures and
appliance shutdown initiations. Critical events might change the status of the
appliance.

Configuring LAN-free backup when using TSM Server v4.2.2
The NAS 200 Model 25T is preloaded with TSM Client, TSM Agent and TSM Driver
Version 4.2.2. When also using TSM Server Version 4.2.2 on a separate server,
configuring the Model 25T to use LAN-free backup to a tape library can be difficult.
To ease this configuration, a TSM macro file is supplied on the Supplementary CD
as file: “\tsm_scripts\tsm_lan_free.mac”. The file contains instructions for using it
during the configuration process.

Configuring page files for optimization
NAS appliances are based on a Windows Powered Operating System and has a
default pagefile of 1024 MB that is located on the boot system drive “C:”. This
default size is based on a minimum base memory configuration for all IBM
TotalStorage appliances and preloaded software. Memory options can vary on each
NAS appliance depending on what you have ordered.

By default, Windows Powered places the pagefile on the boot partition where the
operating system is installed. The pagefile is not a shared disk, but a local disk for
the clustered systems. To determine the size of the pagefile, multiply the amount of
physical RAM by 1.5 to a maximum of 4095 MB. However, placing the pagefile on
the boot partition does not optimize performance because Windows has to perform
disk I/O on both the system directory and the pagefile. Therefore, it is
recommended that you place the pagefile on a different partition (such as the
maintenance partition) or a different physical hard disk drive, so that Windows
Powered can handle multiple I/O requests more quickly. It is highly recommended
that on the NAS appliances, the pagefile be increased by adding to the
Maintenance Partition. The size will vary depending on the physical memory
installed on the appliance. You can check memory by right-clicking My
Computer→properties. This opens a System Properties window, and the memory
will be displayed. This can be performed through Terminal Services or by
connecting a monitor, keyboard, and mouse to the appliance.

Note: Do not remove the pagefile from the boot partition. Removal will not allow
Windows to create a crash dump file (Memory.dmp) in case a kernel mode
STOP error occurs. Not having this crash dump file could lead to extended
server downtime if the STOP requires a debug operation to be performed.

The optimal solution is to create one pagefile on the boot partition using the default
settings and create one pagefile on another, less frequently used partition. The best
option is to create the second pagefile so that it is on its own partition (such as
maintenance partition), with no data or operating system-specific files.

Windows Powered uses the pagefile on the less frequently used partition over the
pagefile on the heavily used boot partition. Windows Powered also uses an internal
algorithm to determine which pagefile to use for virtual memory management. In the
above scenario, the following goals of the page file are served:
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v The system will be properly configured to capture a Memory.dmp file if the
computer experiences a kernel mode STOP error.

v The page file on the less frequently used partition will be used the majority of the
time because it is not on a busy partition.

Another advantage of using a pagefile on its own partition is that the pagefile will
not become fragmented. If the pagefile is on a partition with other data, the pagefile
might experience fragmentation because it expands to satisfy the extra virtual
memory required. A defragmented pagefile leads to faster virtual memory access
and improves the chances of capturing a dump file without significant errors.

Checking Persistent Storage Manager version
The only reliable way to verify the version of PSM on your system is to execute the
following on a command prompt local to the NAS:
c:\winnt\system32\serverappliance\ss -version

An example of the output from this command executed on a system with PSM
version 2261 + 2263 QFE installed is:

C:\WINNT\system32\ServerAppliance>ss -version
ss - Snapshot Command line management utility
Copyright (c) 2000-2002 Columbia Data Products, Inc. All Rights Reserved.

IBM version
LoVersion = 0x00000200
Version = 2.20 build 2262
Eval = no

Date/Time Version File
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\system32\ServerAppliance\psmlapi.dll’
8/13/2002 11:36 2.20.00.2263 ’C:\WINNT\system32\ServerAppliance\ss.exe’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\psmready.exe’
8/06/2002 6:18 2.20.00.2262 ’C:\WINNT\System32\drivers\psman5.sys’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\serverappliance\mui\0409\snapshot.dll’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\serverappliance\PSMCom.dll’
7/26/2002 12:19 2.20.00.2261 ’C:\WINNT\System32\serverappliance\drbackup.dll’

Updated information on Supplementary CDs
This information replaces the information in the section titled “Using the
Supplementary CD” in Chapter 8 of the User’s Reference.

The Supplementary CDs contain documentation and copies of key software
applications that are preinstalled on the NAS 200. Table 2 and Table 3 on page 12
include the names of the directories found on the Supplementary CDs and a
description of the contents of each directory.

Table 2. Supplementary CD 1 directories

Directory name Contents

DB2®
v EnableDB2Support.exe
v DisableDB2Support.exe

These files enable and disable support for Linux- and Solaris-based DB2 clients using
NFS shares.
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Table 2. Supplementary CD 1 directories (continued)

Directory name Contents

DiskImages This directory contains a diskette image for the Recovery Enablement Diskette and
diskette image for a bootable diskette that automatically configures the ServeRAID
controller and drives.

To create the Recovery Enablement Diskette, run enablement_diskette291.EXE and
insert an HD 1.44 floppy diskette into drive A: when prompted.

To create the bootable diskette to automatically configure the ServeRAID controller and
drives, run IBM_NAS_AutoRAID_diskette_2.9.EXE and insert a HD 1.44 floppy diskette
into drive A: when prompted.

diskpart Samples This directory contains an example script for use with the DiskPart utility. This script will
clean disk 2, convert it to dynamic, partition it, and assign drive letters to the partitions.
This script is unsupported and should be used with extreme caution.

IBM Advanced Appliance
Configuration

Run Setup.exe on the machine from which you will administer the appliance. The agent
is preinstalled on the appliance.

IBM NAS Extensions For
IBM Director

The IBM NAS extensions to IBM Director provide capabilities to IBM Director that are
specific to the IBM NAS appliances.

Zip Tools This directory contains compression tools used for sending information to IBM technical
support.

readme.txt This text file describes the contents of the Supplementary CDs.

Table 3. Supplementary CD 2 directories

Directory name Contents

AoP This is the add-on pack for the Server Appliance Kit.

SFU_2073.1 Microsoft® Services for UNIX® (SFU) Version 2.2 support files::

v QFE 320175 for performance enhancements

v QFE 321096 for SAK and SFU performance enhancements

readme_SFN5.txt Instructions for installing Microsoft File and Print Services for NetWare 5.0.

Terminal Services Client Microsoft Terminal Services Client installation files.

w2ksp2 Windows 2000 Service Pack 2.

Fibre Channel adapter event logs
You can view event logging for the Fibre Channel adapter for troubleshooting
problems using the event viewer. The detailed event code is displayed at offset 34
(hex). Table 4 on page 13 gives a list of detailed event codes for the adapter. For
some of the event codes, additional data will be recorded in the least significant 16
bits of the longword. Additional data might also be recorded in the longword at
offset 10 (hex).

Certain codes will be logged only if you set a Fast!UTIL parameter to enable
additional event logging. These codes are indicated by an asterisk (*). By default,
these events are not logged.

If an error occurs that is not listed in Table 4 on page 13, contact the IBM Support
Center (1 800 426-7378 in the U.S.). In all other countries, contact your IBM
reseller or IBM marketing representative.
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Table 4. Fibre Channel adapter error codes

Event code offset
34h

More data offset
10h

Description Suggested action

4002xxxx yyyy00zz Host interface error: xxxx = mailbox1; yyyy =
mailbox2; zz = command

Hardware DMA error:
replace adapter

4005xxxx Yyyy00zz Mailbox command error: xxxx = mailbox1; yyyy
= mailbox2; zz = command

Normally indicates loop
down, check all cabling

4005xx6F yyyyyyzz Login Fabric port mailbox command error: xx =
adapter; state yyyyyy = port id; zz = loop id

Normally indicates loop
down, check all cabling

* 80010000 00000000 Reset detected Not logged during normal
operation

8003xxxx yyyyzzzz RISC request queue transfer error: xxxx =
mailbox1; yyyy = mailbox2; zzzz = mailbox3

Hardware error: replace
adapter

8004xxxx yyyyzzzz RISC response queue transfer error: xxxx =
mailbox1; yyyy = mailbox2; zzzz = mailbox3

Hardware error: replace
adapter

* 80100000 0000xxxx LIP occurred: xxxx = mailbox1 Not logged during normal
operation

* 80110000 xxxxyyzz Link up 2200: xxxx = current ISP connection
mode (0 = Loop, 1 = P2P); yy = ISP
connection option 0 = Loop, 1 = P2P, 2 =
Loop->P2P, 3 = P2P->Loop; zz = starting loop
ID for remote devices. 2100: xxxx = 0000; yyyy
= 0000

Not logged during normal
operation

80120000 00000000 Link down error Not logged during normal
operation

80130000 0000xxxx LIP reset occurred: xxxx = mailbox1 Not logged during normal
operation

**80300000 xxxxyyzz Link mode up: xxxx = current ISP connection
mode 0 = Loop 1 = P2P; yy = ISP connection
option (0 = Loop, 1 = P2P 2 = Loop->P2P 3 =
P2P->Loop); zz = starting loop ID for remote
devices

Not logged during normal
operation

**8036aabb xxxxyyzz Point-to-Point update configuration: xxxx =
mailbox1; yy = current ISP connection mode (0
= Loop, 1 = P2P); zz = ISP connection option
0 = Loop, 1 = P2P, 2 = Loop->P2P, 3 =
P2P->Loop; aa = starting loop ID value for
remote devices; bb = current retry count for the
ISP initialization mode

Not logged during normal
operation

* F0000000 00000000 Restarting RISC firmware Initial driver load or loop
down longer than 4
minutes

* F0030004 00xx00yy Reset command completion error: xx = CDB
opcode; yy = target loop ID

Not logged during normal
operation

* F0030005 00xx00yy Command aborted by OS: xx = CDB opcode;
yy = target loop ID

Not logged during normal
operation

F0030028 00xx00yy Port unavailable, command completion error:
xx = CDB; opcode yy = target loop ID

Check target device and
cabling

F0030029 00xx00yy Port logged out command completion error: xx
= CDB; opcode yy = target loop ID

Check target device and
cabling

F003001C 00xx00yy Target device queue full (SCSI status 28 from
target): xx = CDB opcode; yy = target loop ID

Check target device and
cabling
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Table 4. Fibre Channel adapter error codes (continued)

Event code offset
34h

More data offset
10h

Description Suggested action

* F00A0000 0000xxxx RISC firmware state during adapter
initialization: xxxx = firmware state

Not logged during normal
operation

F00B0000 00000000 Reset ISP chip failed

F00D0000 00000000 Fail to allocate noncached memory

F00E0000 00000000 Fail to map ISP registers

F00F0000 00000000 Fail to load RISC code

F0100000 0000xxxx Fail to start RISC code: xxxx = mailbox0

F0110000 0000xxxx Fail to initialize firmware xxxx = mailbox0

F0120000 0000xxxx Fail to get firmware state: xxxx = mailbox0

* F0130000 00000000 Port Update notification (RISC database
changed)

* F0140000 xxxxxxxx RSCN notification (Name server change
detected): xxxx = RSCN Information

* F0150000 00xx00yy Name server query rejected (v6 2100): xx =
Reason Code; yy = Explanation Code (Valid if
reason code is 0x09)

* F0150000 xxxxyyzz Name server query rejected (v7 2100/2200):
xxxx = response status; yy = Reason Code; zz
= Explanation Code (Valid if reason code is
0x09, for example, if zz = 0x09, yy = 07, this
means no SCSI device found.)

* F0160000 00000000 Driver reset called; command timed out

* F0170000 00xxxxxx Fabric port login (for information only): xxxxxx
= Port Id

F0180000 000000xx Excessive link errors, loop down: xx = number
of link errors per second

* F0190000 00000000 Verify firmware checksum failure

* F01B0000 000000xx Device marked offline after being not-ready
longer than port down retry count: xx = loop ID
of device

* F01C0000 000000xx Bad type field in IOCB from RISC: xx = IOCB
type

* F01D0000 00000000 Error downloading post RISC code

* F01Exxxx Yyyyzzzz Error running post RISC code: xxxx =
mailbox0; Yyyy = mailbox1; zzzz = mailbox2

* F01Fxxyy Zzzzzzzz DMA 64 bit (PAE) configuration (for information
only): xx = Dma64BitAddressess flag set by
W2K; yy = Dma64BitAddressess flag set by
driver; zzzzzzzz = driver adapter flags

F0200000 Xxxxyyyy Error ISP not accessible: xxxx = ISP host
command and control; yyyy = ISP interrupt
status
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Table 4. Fibre Channel adapter error codes (continued)

Event code offset
34h

More data offset
10h

Description Suggested action

* F0210000 xxyy00zz ISP connection option/topology (for information
only): xx = ISP connection option from
NVRAM; yy = previous ISP topology; zz =
current ISP topology code: 0000 = Loop, 0001
= FL_Port, 0002 = N_Port to N_Port, 0003 =
F_Port

* F0220000 0000xxxx External RISC ram parity error (for 2200G
only): xxxx = number of parity errors detected

* F0230000 Xxxxyyyy Subvendor ID not match (for information only):
xxxx = actual subvendor ID; yyyy = expected
subvendor ID

Persistent Storage Manager event log messages
If you experience problems while using the Persistent Storage Manager to create,
schedule, or delete persistent images, or while using the NAS Backup Assistant or
IBMSNAP.EXE to perform a Persistent Image backup, use the Table 5 to
troubleshoot any problems. Each of these messages are logged to the system
event log by the PSMAN5 driver (file system driver for Persistent Storage Manager
(PSM)); each entry appears with “psman5” as the source name.

For more information about Persistent Storage Manager and persistent images, see
the User’s Reference.

Table 5. Persistent Storage Manager event log messages

Error Code Description Action

0x00000001 An invalid IOCTL was sent to the driver. Contact IBM technical support.

0x00000002 Device name is not recognized by PSM. Contact IBM technical support.

0x00000003 An invalid path was given for the cache file.
This error will appear if the cache file cannot
be created because the cache file drive is not
present.

Contact IBM technical support.

0x00000005 An exception occurred. Contact IBM technical support.

0x00000005 You do not have sufficient rights to the cache
file directory.

Contact IBM technical support.

0x00000005 The cache file specified is a directory instead
of a file.

Contact IBM technical support.

0x00000005 PSM was told to shut down. Contact IBM technical support.

0x00000006 User performing PSM function without
opening PSM.

Contact IBM technical support.

0x00000015 Access to a virtual volume has been
attempted after the virtual volume has been
destroyed.

Do not access virtual volumes after they
have been destroyed.

0x00000016 Something has gone wrong with PSM. Contact IBM technical support.

0x00000017 Bad sector was detected in the cache file. Contact IBM technical support.

0x0000001F General failure. Contact IBM technical support.

0x00000057 An invalid parameter was passed to a
function.

Contact IBM technical support.
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Table 5. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0x00000079 I/O timed out while reading from the cache
file.

Contact IBM technical support.

0x0000007A Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0x000000A1 An invalid path was given for the cache file. Contact IBM technical support.

0x000000EA Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0x000003E6 An exception occurred. Contact IBM technical support.

0x00000456 PSM was stopped because the media of a
device was changed on which PSM was
running.

Contact IBM technical support.

0x0000045D An error occurred on the device. Contact IBM technical support.

0x000005AA There is insufficient memory available. Contact IBM technical support.

0x000006F8 Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0x000006F8 Invalid buffer address passed for I/O. Contact IBM technical support.

0x80000005 Specified buffer size is too low. Contact IBM technical support.

0x8000001C PSM was stopped because the media of a
device was changed on which PSM was
running.

Take a new persistent image.

0xA0000004 The cache file is <x>% full. The oldest
persistent images will automatically be deleted
at <y>%.

This is a warning that the cache file size is
approaching the threshold at which some
persistent images will be deleted automatically
to free up some cache file capacity. <x> is the
percentage for which the warning message
will be generated, and <y> is the percentage
that represents the threshold. (By default,
these values are 80% and 90%, respectively,
and can be modified in Windows 2000 for
NAS (Disks/Persistent Storage Manager).)

In Windows 2000 for NAS
(Disks/Persistent Storage Manager), delete
some (noncritical) persistent images before
the system does to guarantee that critical
persistent images do not get deleted
accidentally.

0xC0000001 General failure. Contact IBM technical support.

0xC0000002 Function is not yet implemented. Contact IBM technical support.

0xC0000005 An Access Exception occurred. Contact IBM technical support.

0xC0000008 User performing PSM function without
opening PSM.

Contact IBM technical support.

0xC000000D An invalid parameter was passed to a
function.

Contact IBM technical support.

0xC000000E Device name is not recognized by PSM. Contact IBM technical support.

0xC0000010 An invalid IOCTL was sent to the driver. Contact IBM technical support.

0xC0000013 Access to a virtual volume has been
attempted after it has been destroyed.

Contact IBM technical support.

0xC000001C An invalid IOCTL was sent to the driver. Contact IBM technical support.

0xC0000022 An access exception occurred. Contact IBM technical support.
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Table 5. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0xC0000022 You do not have sufficient rights to the cache
file directory.

Contact IBM technical support.

0xC0000023 Specified buffer size is too small. Contact IBM technical support.

0xC0000034 Cache file name is invalid. Contact IBM technical support.

0xC000003A An invalid path was given for the cache file. Contact IBM technical support.

0xC000003B An invalid path was given for the cache file. Contact IBM technical support.

0xC000003E Bad sector was detected in the cache file. Contact IBM technical support.

0xC0000043 A file cannot be opened because the share
access flags are incompatible.

This occurs when the very last persistent
image is deleted. PSM initializes its files
when the last persistent image is deleted.
While it is initializing, a new persistent
images can not be created. Try again in a
few minutes.

0xC000009A There is insufficient memory available. Contact IBM technical support.

0xC00000B5 I/O timed out while reading from the cache
file.

Contact IBM technical support.

0xC00000BA The cache location must be a file rather than
a directory.

Contact IBM technical support.

0xC00000E8 Invalid buffer address passed for I/O. Contact IBM technical support.

0xC000010A PSM was told to shut down. Contact IBM technical support.

0xC0000184 Something has gone wrong with PSM. Contact IBM technical support.

0xC0000185 An error occurred on the device. Contact IBM technical support.

0xC0000206 Buffer size supplied is insufficient to hold
requested information.

Contact IBM technical support.

0xE0001001 PSM could not start due to the server being
constantly busy for <x> minutes.

Take a persistent image when NAS
appliance demands are lower.

0xE0001002 PSM detected a deadlock. Contact IBM technical support.

0xE0001003 Specified volume not active or deleted. Do not delete volumes with active
persistent images.

0xE0001004 PSM was specified for a volume on which
PSM is not running.

Contact IBM technical support.

0xE0001005 Cache file overflow caused all existing
persistent images to be deleted.

Increase the cache file size in Windows
2000 for NAS (Disks/Persistent Storage
Manager), or take or schedule persistent
images when fewer users are online.

0xE0001006 The application tried to enable PSM without
first calling PSM_Register.

Contact IBM technical support.

0xE0001007 Invalid license code. Contact IBM technical support.

0xE0001008 Another application already has PSMed
locked exclusively.

Contact IBM technical support.

0xE0001009 PSM needs to be locked exclusive for this
function to work.

Contact IBM technical support.

0xE000100A Wrong version of the driver has been loaded
on this system.

Contact IBM technical support.
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Table 5. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0xE000100B A reboot is required before PSM can operate. Reboot the appliance, and try taking a
persistent image again. If this still fails,
contact IBM technical support.

0xE000100C PSM is not installed. Contact IBM technical support.

0xE000100D An incompatible DLL from another version of
PSM is already loaded.

Contact IBM technical support.

0xE000100E Out of memory. Contact IBM technical support.

0xE000100F Invalid parameter. Contact IBM technical support.

0xE0001010 Invalid handle. Contact IBM technical support.

0xE0001011 Not implemented yet. Contact IBM technical support.

0xE0001012 Object type is not expected object. Contact IBM technical support.

0xE0001013 User buffer is not large enough. Contact IBM technical support.

0xE0001014 Out of available structures. In Windows 2000 for NAS
(Disks/Persistent Storage Manager), delete
some persistent images.

0xE0001015 PSM is shutting down. Contact IBM technical support.

0xE0001016 The device, volume or object does not exist. Contact IBM technical support.

0xE0001017 Unsuccessful. Contact IBM technical support.

0xE0001018 The device does not have any media loaded. Contact IBM technical support.

0xE0001019 Object already exists. Contact IBM technical support.

0xE000101A Specified path is a directory and not a file. Contact IBM technical support.

0xE000101B Invalid path was specified. Contact IBM technical support.

0xE000101C The static volume was not mounted. Look at the system event log for a warning
message (from the PSMAN5 service)
whose code should appear in this list. The
action depends on the message.

0xE000101D The static volume had errors during mount. Look at the system event log for a warning
message (from the PSMAN5 service)
whose code should appear in this list. The
action depends on the message.

0xE000101E The static volume could not be found. Contact IBM technical support.

0xE000101F The volume the cache file resides on is out of
space.

The cache file for each volume resides on
the volume itself. Free some space on the
volume.

0xE0001020 The volume the cache file resides on was
dismounted.

The cache file for each volume resides on
the volume itself. Do not dismount the
volume.

0xE0001021 The server was shut down. Do not shut down the IBM TotalStorage
NAS appliance while persistent images are
in progress.

0xE0001022 Unable to create cache file. Contact IBM technical support.

0xE0001023 PSM recovery could not find a persistent
image entry.

A persistent image was lost during the
recovery process. It is unknown which
persistent image it was.

Contact IBM technical support.
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Table 5. Persistent Storage Manager event log messages (continued)

Error Code Description Action

0xE0001024 PSM recovery could not open the index file.
All persistent images are corrupt.

Contact IBM technical support.

0xE0001025 PSM recovery encountered error <x>inserting
key (<y>:<z>) into dictionary.

<x> is the error that occurred and can be
found in this list of errors.

Look up the error in this list and take the
specified action.

0xE0001026 PSM recovery encountered corrupt index
sector %2.

An index entry was found to be corrupt during
the last boot.

Contact IBM technical support.

0xE0001027 A persistent image could not be created due
to error 0x<x>.

<x> is the error that occurred.

Look up the error in this list and take the
specified action.

0xE0001028 The cache file is <x>% full. Persistent images
have been deleted.

The oldest persistent images have been
deleted.

In Windows 2000 for NAS
(Disks/Persistent Storage Manager), delete
persistent images to make sure specific
(critical) persistent images are not
destroyed by mistake.

0xE0001029 The maximum (<x>) allowed persistent
images has been reached. A persistent image
was not created.

PSM cannot create any more persistent
images because the configured maximum
number of persistent images that PSM can
keep concurrently has been reached.

In Windows 2000 for NAS
(Disks/Persistent Storage Manager)
increase the number of persistent images
allowed, or edit the schedules to not make
so many persistent images.

Trademarks
DB2, IBM, the IBM logo, IBM Director, SANergy, ServeRAID, TotalStorage, Tivoli
and are trademarks or registered trademarks of International Business Machines
Corporation or Tivoli Systems Inc. in the United States, other countries, or both.

Alacritech and SLIC Technology are registered trademarks of Alacritech, Inc. in the
United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks or registered trademarks of
Microsoft Corporation.

Persistent Storage Manager is a trademark of Columbia Data Products, Inc.

UNIX is a registered trademark in the United States, other countries, or both, and is
licensed exclusively through X/Open Company Ltd.

Other company, product, and service names may be trademarks or service marks
of others.
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